
A li d M k t A li d M k t Applied Market Applied Market 
Research and AnalysisResearch and AnalysisResearch and AnalysisResearch and Analysis

Introductions
Basic ProblemsBasic Problems 

Research Process
I d ti /D d ti R hInductive/Deductive Research



James Reardon, PhD (Jim)James Reardon, PhD (Jim)
AcademicAcademic– Academic
• BS (CIS), MBA, PhD (Mktg)

U fTN UNC U fA KIMEP U fLj

– Academic
• BS (CIS), MBA, PhD (Mktg)

U fTN UNC U fA KIMEP U fLj• UofTN, UNC, UofAntwerp, KIMEP, UofLju
• Research/Scholarship
• UofTN, UNC, UofAntwerp, KIMEP, UofLju
• Research/Scholarship

– Industry
• Own/Mgmt

– Industry
• Own/Mgmt

– Construction, Retail, Casino, Film Distribution, E-com 

• Mgmt – TV shopping, Consulting
– Construction, Retail, Casino, Film Distribution, E-com 

• Mgmt – TV shopping, Consulting
– Personal– Personal



IntroductionsIntroductionsIntroductionsIntroductions

• Name
• Industry experience
• Name
• Industry experience• Industry experience
• Goals – i.e., why are you here?
• Industry experience
• Goals – i.e., why are you here?
• Interesting• Interesting



P bl  R i i  P bl  R i i  Problems Requiring Problems Requiring 
ResearchResearchResearchResearch

e.g.  A.C.N. 
Putting Out Fires 

VS 
Solving Underlying Problems



Why do research?Why do research?yy
Topic What we typically know What we usually don’t

Opportunity AnalysisOpportunity Analysis 
(GAP/SWOT)
Product
PricePrice
Distribution
Communication
Raw Materials
Producer
WholesalerWholesaler
Retailer



Research ProcessResearch Process

1 • Determine Research Problem1

2 • Select Appropriate Design

3 • Execute Research

4 • Communicate Results



Iceberg Principle (Exh 2.5)Iceberg Principle (Exh 2.5)

SymptomsSales y pSales
Share
Complaints

Expectations
Sales force

Opportunities
Competition

Problems/Decisions

Sales force
Execution

Competition
Environment

(Research)



Assignment for TodayAssignment for TodayAssignment for TodayAssignment for Today

• What is your research question?
• Is it a managerial or research
• What is your research question?
• Is it a managerial or research• Is it a managerial or research 

problem?  Identify both for the problem 
at hand

• Is it a managerial or research 
problem?  Identify both for the problem 
at handat hand.at hand.



D d ti  d D d ti  d Deductive and Deductive and 
Inductive ResearchInductive ResearchInductive ResearchInductive Research

Causal
PredictivePredictive
Descriptive



• Define
• Causality – Time, Correlation, and Logic

• Define
• Causality – Time, Correlation, and Logicy , , g
• Prediction – Correlation and Time?
• Description – Situation as it exists

y , , g
• Prediction – Correlation and Time?
• Description – Situation as it existsDescription Situation as it exists

• Processes
C lit R i H th i T t

Description Situation as it exists

• Processes
C lit R i H th i T t• Causality – Review, Hypothesis, Test

• Prediction – Test
D i ti Sh

• Causality – Review, Hypothesis, Test
• Prediction – Test

D i ti Sh• Description – Show• Description – Show



So which do we use?So which do we use?
ff– Purpose – make an informed decision at 

limited risk/exposure
– Purpose – make an informed decision at 

limited risk/exposure
– Cost versus Benefits

• Benefits
– Cost versus Benefits

• Benefits
– Revenue, Market Share, Strategic

• Costs
– Revenue, Market Share, Strategic

• Costs
– Time – Labor/Talent and Opportunity cost
– Budget

Risk importance

– Time – Labor/Talent and Opportunity cost
– Budget

Risk importance– Risk – importance
– Image/Brand Equity
– Risk – importance
– Image/Brand Equity



Which do I use? (loose criteria)Which do I use? (loose criteria)Which do I use? (loose criteria)Which do I use? (loose criteria)
Buying Television Time ($50Mil+ per year 200+ contracts)Buying Television Time ($50Mil+ per year 200+ contracts)

Criteria Descriptive Predictive CausalCriteria Descriptive
Info for Contract

Predictive
Modeling Est. Sales

Causal
Reexamine Model

Cost < $100K > $200K $5M+

Relationship
w/Seller

Excellent/Good Poor None

Market Si e/Charac Similar to E isting Ne Ver Large/Un s alMarket Size/Charac Similar to Existing New Very Large/Unusual

Type (Broadcast,
Cable, Satellite)

Broadcast Any New Type

Channel # 99, 1-23 24-60 100+

Other Company Strategy Unusual 



When not to use researchWhen not to use research

– Time/Budget restrictions– Time/Budget restrictionsTime/Budget restrictions
• Limited time opportunities – closeouts

– The answer is obvious (be careful)

Time/Budget restrictions
• Limited time opportunities – closeouts

– The answer is obvious (be careful)– The answer is obvious (be careful)
– Limited value of decision
– The answer is obvious (be careful)
– Limited value of decision
– Information is trendy but not used
– Give the competitor information 
– Information is trendy but not used
– Give the competitor information 

• Product Launches• Product Launches



Other uses of Mktg  ResearchOther uses of Mktg  ResearchOther uses of Mktg. ResearchOther uses of Mktg. Research

Id G iId G i• Idea Generation
• Internal – Mgmt. etc..
• Idea Generation
• Internal – Mgmt. etc..Internal Mgmt. etc..
• Questionable Uses

Internal Mgmt. etc..
• Questionable Uses

– Self Promotion – Ethical? Research?
– “Proof of Concept” i.e., Political
– Self Promotion – Ethical? Research?
– “Proof of Concept” i.e., Political



S d  D tS d  D tSecondary DataSecondary Data
(being efficient)(being efficient)(being efficient)(being efficient)

Definitions
Internal vs. 

E t l SExternal Sources



DefinitionsDefinitionsDefinitionsDefinitions
• Secondary – Gathered not for the • Secondary – Gathered not for the 

purposes at hand
– Internal – Gathered by company
purposes at hand

– Internal – Gathered by companyInternal Gathered by company
• Note:  Some data w/i company is not 

gathered by the company – e.g., compiled

Internal Gathered by company
• Note:  Some data w/i company is not 

gathered by the company – e.g., compiledgathered by the company e.g., compiled 
databases

– External – Gathered by someone else

gathered by the company e.g., compiled 
databases

– External – Gathered by someone elseExternal Gathered by someone elseExternal Gathered by someone else



Why/Why Not Secondary InfoWhy/Why Not Secondary InfoWhy/Why Not Secondary InfoWhy/Why Not Secondary Info
• Benefits• Benefits • Costs• Costs

– Speed 
– Cost
– Speed 
– Cost

– Fit/Purpose
– Accuracy
– Fit/Purpose
– Accuracy

– Access
– Ease
– Access
– Ease

– Consistency
– Credibility
– Consistency
– Credibility
– Methodology
– Bias
– Methodology
– Bias



Internal Data Internal Data 
(Exhibit 4.1-4.2, p.64-5)(Exhibit 4.1-4.2, p.64-5)

Cheapest (Time and Mone )Cheapest (Time and Mone )• Cheapest (Time and Money)
• Most Accessible 
• Cheapest (Time and Money)
• Most Accessible 

– Who are your friends at work?
• Accuracy Best knowledge of

– Who are your friends at work?
• Accuracy Best knowledge of• Accuracy - Best knowledge of 

source/procedures for compilation
• Accuracy - Best knowledge of 

source/procedures for compilation



Example of Secondary dataExample of Secondary data
(External)(External)

• http://en.wikipedia.org/wiki/List_of_countries_by_GDP_(nominal)

– Italy ½% off – also see #12/13 rank
• http://www indexmundi com/italy/gdp real growth rate html -- 0 10%

• http://en.wikipedia.org/wiki/List_of_countries_by_GDP_(nominal)

– Italy ½% off – also see #12/13 rank
• http://www indexmundi com/italy/gdp real growth rate html -- 0 10%• http://www.indexmundi.com/italy/gdp_real_growth_rate.html -- 0.10%
• http://www.imf.org/external/np/ms/2006/111306.htm -- 1.75%
• https://www.cia.gov/library/publications/the-world-factbook/geos/it.html -- 1.9%

Wh ?

• http://www.indexmundi.com/italy/gdp_real_growth_rate.html -- 0.10%
• http://www.imf.org/external/np/ms/2006/111306.htm -- 1.75%
• https://www.cia.gov/library/publications/the-world-factbook/geos/it.html -- 1.9%

Wh ?• Why?• Why?



External DataExternal Data
(by reliability)(by reliability)

Commercial/S ndicatedCommercial/S ndicated• Commercial/Syndicated
– Live and Die by accuracy of information

• Commercial/Syndicated
– Live and Die by accuracy of information
– No inherent bias to produce 
– http://www.knowthis.com/market-research/leading-marketing-research-companies.htm

– No inherent bias to produce 
– http://www.knowthis.com/market-research/leading-marketing-research-companies.htm

– AC Nielson  http://acnielsen.com/company/about_nielsen.shtml

– Euromonitor http://www.euromonitor.com/

– AC Nielson  http://acnielsen.com/company/about_nielsen.shtml

– Euromonitor http://www.euromonitor.com/

– GIS systems – combine proprietary software with government data– GIS systems – combine proprietary software with government data



• Government/Related Orgs• Government/Related Orgs
– Limited rationale for bias of data
– Limited incentive for accuracy
– Limited rationale for bias of data
– Limited incentive for accuracyLimited incentive for accuracy

• UN and Related
• EU

Limited incentive for accuracy
• UN and Related
• EUEU
• OECD
• Governments

EU
• OECD
• Governments• Governments

– Usually Ministry of Economics/Finance
– US – Department of Commerce

• Governments
– Usually Ministry of Economics/Finance
– US – Department of Commercepp



• Trade/Industry Groups• Trade/Industry Groups
– Some rationale for bias of data

• PR for Industry (e.g., Tobacco)
– Some rationale for bias of data

• PR for Industry (e.g., Tobacco)y ( g , )
– Limited incentive for accuracy

• Dependent on members for volunteer

y ( g , )
– Limited incentive for accuracy

• Dependent on members for volunteerDependent on members for volunteer 
information

– For almost all industries/trades/hobbies

Dependent on members for volunteer 
information

– For almost all industries/trades/hobbiesFor almost all industries/trades/hobbies
• http://www.marketingsource.com/associations/information.html
• http://gale.com/servlet/BrowseSeriesServlet?region=9&imprint=

000&cf=ps&titleCode=EA1&edition

For almost all industries/trades/hobbies
• http://www.marketingsource.com/associations/information.html
• http://gale.com/servlet/BrowseSeriesServlet?region=9&imprint=

000&cf=ps&titleCode=EA1&edition000&cf=ps&titleCode=EA1&edition000&cf=ps&titleCode=EA1&edition



Tuesday AssignmentTuesday AssignmentTuesday AssignmentTuesday Assignment

•Read as per course outline
•Refine your research question.Refine your research question.
•What type of research?

• See previous table
•Suggest potential causes.Suggest potential causes.

• Use simple logic for now



Assignment (continued)Assignment (continued)Assignment (continued)Assignment (continued)
• Identify 2-4 Exploratory sources to• Identify 2-4 Exploratory sources toIdentify 2 4 Exploratory sources to 

further define or answer your R Q
Fi d i f ti l t d t

Identify 2 4 Exploratory sources to 
further define or answer your R Q
Fi d i f ti l t d t• Find information related to your 
question as available.

• Find information related to your 
question as available.



Applied Marketing Applied Marketing Applied Marketing Applied Marketing 
Research and AnalysisResearch and Analysis

T d    18T d    18 33 0808Tuesday   18Tuesday   18--33--0808

Finding Evidence 
to Solve Problemsto Solve Problems



AssignmentsAssignmentsAssignmentsAssignments

• Reformulated Question
• Descriptive Predictive or Causal?
• Reformulated Question
• Descriptive Predictive or Causal?• Descriptive, Predictive or Causal?

– Why?
• Descriptive, Predictive or Causal?

– Why?
• Potential Answers/Causes? 
• Secondary sources
• Potential Answers/Causes? 
• Secondary sourcesSecondary sourcesSecondary sources



Q alitati e/E plorator  Q alitati e/E plorator  Qualitative/Exploratory Qualitative/Exploratory 
OverviewOverview

Purpose
Types/ProceduresTypes/Procedures



e g  Clothing in Argentinae g  Clothing in Argentinae.g., Clothing in Argentinae.g., Clothing in Argentina

• Clothing Designer/Producer
– Very successful

• Clothing Designer/Producer
– Very successfulVery successful
– Wanted to export to France 

Very successful
– Wanted to export to France 



Literature ReviewLiterature Review

• Should always start here after internal • Should always start here after internal 
data – easy, quick and inexpensive

– Academic Literature – personal view
data – easy, quick and inexpensive

– Academic Literature – personal viewAcademic Literature personal view
– Trade Rags

C St di id

Academic Literature personal view
– Trade Rags

C St di id– Case Studies – ideas
– General Internet
– Case Studies – ideas
– General Internet



Types of Qualitative/ Types of Qualitative/ 
ExploratoryExploratory

• Key Informant/Experience/Depth 
Surveys/Interviews

• Key Informant/Experience/Depth 
Surveys/InterviewsSu eys/ e e s

– Want to know the answer…..
Sometimes the shortest path is most

Su eys/ e e s
– Want to know the answer…..

Sometimes the shortest path is most– Sometimes the shortest path is most 
obvious/direct

/ ff f

– Sometimes the shortest path is most 
obvious/direct

/ ff f– KI/Experience differ slightly from Depth – KI/Experience differ slightly from Depth 



Focus Groups (Exhibit 5.5)Focus Groups (Exhibit 5.5)
• Most popular method

M d t i k
• Most popular method

M d t i k• Moderator is key
– Not control, but guide and record

• Moderator is key
– Not control, but guide and recordg

• 8-12 People – homogenous group
4 8 diff t h t it

g
• 8-12 People – homogenous group

4 8 diff t h t it• 4-8 different groups - heterogeneity
• 1.5-2 hours
• 4-8 different groups - heterogeneity
• 1.5-2 hours



ObservationObservationObservationObservation
• Ethnography• Ethnography

– Watch and see 
– Some activities are highly affected by 
– Watch and see 
– Some activities are highly affected by g y y

Hawthorne effect
• Netnography

g y y
Hawthorne effect

• NetnographyNetnography
– Artificial Environment of net –
Netnography

– Artificial Environment of net –
– Alt. or discussion groups– Alt. or discussion groups



Projective TechniquesProjective TechniquesProjective TechniquesProjective Techniques
• Word Associations• Word Associations
• Sentence Completion
• Group story telling
• Sentence Completion
• Group story telling• Group story telling
• TAT – tell me a story from a picture
• Group story telling
• TAT – tell me a story from a picture



New Projective New Projective New Projective New Projective 
• ZMET –• ZMET –ZMET 

– Individually Gather Pics of subject
A G

ZMET 
– Individually Gather Pics of subject

A G– As a Group
• Compare/contrast

– As a Group
• Compare/contrast
• Create a story/movie
• Summarize them into an image
• Create a story/movie
• Summarize them into an image



Assignment for Wed 19-3-08Assignment for Wed 19-3-08
Part IPart I

• Identify 2-4 Qualitative techniques to• Identify 2-4 Qualitative techniques toIdentify 2 4 Qualitative techniques to 
further define or answer your R Q
D l th t i l t

Identify 2 4 Qualitative techniques to 
further define or answer your R Q
D l th t i l t• Develop the materials necessary to 
conduct

• Develop the materials necessary to 
conduct

– Who?
– Guides
– Who?
– Guides– Guides
– Data Capture/Forms
– Guides
– Data Capture/Forms



P i  R h P i  R h Primary Research Primary Research 
Quantitative OverviewQuantitative OverviewQuantitative OverviewQuantitative Overview

Measurement Basics
Survey DesignSurvey Design



Measurement BasicsMeasurement Basics

Definitions
Rules of ThumbRules of Thumb



Measurement BasicsMeasurement Basics
• Important when developing questions
• Type of Data
• Important when developing questions
• Type of Data• Type of Data 

• Nominal, Ordinal, Interval, Ratio
Binary some special rules apply

• Type of Data 
• Nominal, Ordinal, Interval, Ratio

Binary some special rules apply• Binary – some special rules apply

• ROTs
• Binary – some special rules apply

• ROTs
• Use highest level data possible
• Don’t over-specify
• Use highest level data possible
• Don’t over-specify

– meters w/ micrometers– meters w/ micrometers



Measurement LevelsMeasurement Levels
Scale Types Assigning 

Rules
Application Stats

N i l Bi Obj t ith Cl ifi ti M d % ChiNominal Binary,
Category

Objects either 
identical or 
different

Classification Mode,%, Chi-
Squared

Ordinal/Rank Comparative, 
Rank, Paired
Comparison

Objects greater 
or smaller than 
other

Rankings,
relative 
preferences,

Percentile,
Median, S. 
Correlation

Interval Likert, 
Stapel, SD

Equal intervals 
no absolute 0

Attitude scales
temperature

Mean, nearly
all stats

Ratio Physical Same as above Sales income MeanRatio Physical, 
money

Same as above 
except 0 has 
meaning

Sales, income,
production etc.

Mean 
(geometric), all 
stats 



Survey DesignSurvey DesignSurvey DesignSurvey Design
How (not) to ask a QHow (not) to ask a Q

Types
FormatFormat

Presentation



When in doubt – refer back to When in doubt – refer back to 
research question/problemresearch question/problem

• Create “data needs” and rank them• Create “data needs” and rank themCreate data needs  and rank them
– Absolutely need

P b bl d

Create data needs  and rank them
– Absolutely need

P b bl d– Probably need
– Would be nice
– Probably need
– Would be nice
– Interesting

• If this is done poorly everything will be
– Interesting

• If this is done poorly everything will be• If this is done poorly, everything will be• If this is done poorly, everything will be



Data NeedsData Needs
Research Q Variable 

Name
Use Units Unit/Type

Outcomes Measure effect
Sales GSales Outcome 000 Euro Ratio
Hypothesized 
A t d t

Check 
t d tAntecedents antecedents

Ad Expend AdExpen Effect 000 Euro and 
lagged -1 to -4

Ratio

Predictive Related, not 
causal

Season Fall Spring Predictive 0 if not BinarySeason Fall, Spring, 
Winter,
Summer

Predictive 0 if not 
season,  1 if 
season

Binary



Types of Survey CollectionTypes of Survey Collection
Exhibit 6.2Exhibit 6.2

• Personal Interviews
– Home vs. Mall Intercept

• Personal Interviews
– Home vs. Mall InterceptHome vs. Mall Intercept

• Telephone
Home vs. Mall Intercept

• Telephone
• Self Administered

– Mail, Online, Drop-offs
• Self Administered

– Mail, Online, Drop-offsa , O e, op o sa , O e, op o s



Personal Telephone Self AdminPersonal Telephone Self Admin

Cost Highest High Low

Speed Fast Fastest Slow

Adaptability
( ti li fl )

Best Good Limited
(stimuli, flow)
Anonymity Limited None Best

M it i Abilit OK B t Li it dMonitoring Ability OK Best Limited

Data Quality Best Good Limited
C li ti I t i bi N R N RComplications Interviewer bias Non-Response

Legal
No home phone

Non-Response

Used best for: Depth Politics Personal/
Confidential



Errors to AvoidErrors to Avoid
I t i BiI t i Bi• Interviewer Bias

– Demographics that create the highest 
• Interviewer Bias

– Demographics that create the highest 
response rate will also create the highest 
bias.
response rate will also create the highest 
bias.

• Interviewer Shortcuts/Cheating
People will take path of least resistance

• Interviewer Shortcuts/Cheating
People will take path of least resistance– People will take path of least resistance 
when not properly supervised

Lazy sampling friends/self completed etc

– People will take path of least resistance 
when not properly supervised

Lazy sampling friends/self completed etc• Lazy sampling, friends/self completed etc…
• Mostly after enough experience (boredom)
• Lazy sampling, friends/self completed etc…
• Mostly after enough experience (boredom)



Sampling – AbreviatedSampling – Abreviated
S fS f– Sample should be representative of 
population of interest

– Sample should be representative of 
population of interest

– Larger the better 
• You can weight for lopsided representative

– Larger the better 
• You can weight for lopsided representative

– Probability – Simple random usually best
• Statistically more correct

– Probability – Simple random usually best
• Statistically more correctStatistically more correct
• Difficult to achieve
Non Probability

Statistically more correct
• Difficult to achieve
Non Probability– Non-Probability
• Cheap, easy and adjustable

– Non-Probability
• Cheap, easy and adjustable



Designing a Survey - QuestionsDesigning a Survey - Questions
– KISS – 12 yr old understands – unless 

expert interviews
– KISS – 12 yr old understands – unless 

expert interviewsp
– Scales – Ratio if possible (high as poss)

Bad Questions

p
– Scales – Ratio if possible (high as poss)

Bad Questions– Bad Questions
• Unanswerable

L di /L d d

– Bad Questions
• Unanswerable

L di /L d d• Leading/Loaded
• Double Barreled

C l t d

• Leading/Loaded
• Double Barreled

C l t d• Convoluted
• Quick and Easy to answer
• Convoluted
• Quick and Easy to answer



Designing a Survey - LayoutDesigning a Survey - Layout
– Appealing/Simple

Whitespace/Crowded
– Appealing/Simple

Whitespace/Crowded– Whitespace/Crowded
– Flow
– Whitespace/Crowded
– Flow

• Instructions – thank you, you are important
• First Question 
• Instructions – thank you, you are important
• First Question 

– Interesting
– Answer is often “Yes”

• More difficult or personal questions last

– Interesting
– Answer is often “Yes”

• More difficult or personal questions last• More difficult or personal questions last• More difficult or personal questions last



Basic Question TypesBasic Question Types
Type Advantages Disadvantages ROT

Semantic Diff
Lik t S l

Simple easy and 
i k

What does a “4”
?

7 +/-2 points
M th b ttLikert, Scale quick mean? More the better

Ranking Relative Importance Space between 
ranks

No more than 6

Binary Very Easy/Quick Limited Info 0 not present, 1 
present

Categories Easier than Open Precision Use “other”Categories Easier than Open
ended

Precision Use other

Constant Sum Relative and 
eighted

Difficult for Avg.
person to ans er

Adjust to scale
weighted person to answer

All that Apply Multiple category Limited to 
membership

Code binary, use 
“other”



Other Important InfoOther Important InfoOther Important InfoOther Important Info

• Ch 9 does an excellent job on the 
process of survey design

• Ch 9 does an excellent job on the 
process of survey designp ocess o su ey des g

• Exhibits 9.4 – 9.7 – good rules
p ocess o su ey des g

• Exhibits 9.4 – 9.7 – good rules



Avoiding ErrorsAvoiding Errors
• Pretest, Pretest, Pretest
• Mutually exclusive, totally exhaustive
• Pretest, Pretest, Pretest
• Mutually exclusive, totally exhaustiveMutually exclusive, totally exhaustive

– Other______________
Ch k ll th t l

Mutually exclusive, totally exhaustive
– Other______________

Ch k ll th t l– Check all that apply
• CYA – client approval 

– Check all that apply
• CYA – client approval pp

– e.g., Union Colony – billboards
• Open/Closed ended Q

pp
– e.g., Union Colony – billboards

• Open/Closed ended Q• Open/Closed ended Q –
– pay now or pay later

• Open/Closed ended Q –
– pay now or pay later



Assignment for Wed 19-3-08Assignment for Wed 19-3-08
Part IIPart II

• Read assigned Chapters/Parts
• Create a “data needs” sheet
• Read assigned Chapters/Parts
• Create a “data needs” sheet• Create a data needs  sheet
• Design a Survey/Data Collection 
• Create a data needs  sheet
• Design a Survey/Data Collection 

InstrumentInstrument



Applied Marketing Applied Marketing Applied Marketing Applied Marketing 
Research and AnalysisResearch and Analysis

W d d  19W d d  19 33 0808Wednesday 19Wednesday 19--33--0808

Data Analysis
InterpretationInterpretation
Presentation



Preparing/Entering DataPreparing/Entering Data

SPSS/Excel
CodingCoding

Checking



SPSSSPSS
• Most can be done in Excel with more• Most can be done in Excel with more• Most can be done in Excel with more 

difficulty
• Most can be done in Excel with more 

difficulty
• Windows

– Data
• Windows

– DataData
• Data View (tab)
• Variable View (tab)

Data
• Data View (tab)
• Variable View (tab)• Variable View (tab)

– Output
S t l l ti l i

• Variable View (tab)
– Output

S t l l ti l i– Syntax – close unless repeating analysis– Syntax – close unless repeating analysis



Practical CodingPractical Coding
E h h i ID bE h h i ID b• Each survey has unique ID number

• Likert, Semantic Differential, Etc.
E t b i l d/ d

• Each survey has unique ID number
• Likert, Semantic Differential, Etc.

E t b i l d/ d– Enter number circled/measured

• Yes/No Questions
– Dummy code – 1 yes, 0 if no

– Enter number circled/measured

• Yes/No Questions
– Dummy code – 1 yes, 0 if noy y ,

• Demographics
– 1 if Male/Female (self), 0 if other
– Mean of categories (central limit theorm)

y y ,

• Demographics
– 1 if Male/Female (self), 0 if other
– Mean of categories (central limit theorm)Mean of categories (central limit theorm)

• Check all that Apply
– Separate variables for each choice
– Dummy code – 1 if checked 0 if not

Mean of categories (central limit theorm)

• Check all that Apply
– Separate variables for each choice
– Dummy code – 1 if checked 0 if notDummy code 1 if checked, 0 if not

• Leave empty if no answer
Dummy code 1 if checked, 0 if not

• Leave empty if no answer



AssignmentAssignmentAssignmentAssignment

• Code your survey design from today’s 
assignment

• Code your survey design from today’s 
assignmentass g eass g e



Office CheckingOffice CheckingOffice CheckingOffice Checking
• Descriptives• Descriptivesp

– Check the range (min/max) and rest to 
see if they make sense

p
– Check the range (min/max) and rest to 

see if they make sensesee if they make sense
• Frequencies

see if they make sense
• Frequencies

– Quick look to check for ‘odd’ entries
– Do not “print” if interval level data
– Quick look to check for ‘odd’ entries
– Do not “print” if interval level datapp



Dataset DescriptionDataset Description
• Subjects: 200+ Undergrad students 

from here
• Subjects: 200+ Undergrad students 

from herefrom here
• Variables

from here
• Variables

– Music – Buy/Burn
– Antecedents – as per dataset
– Music – Buy/Burn
– Antecedents – as per datasetAntecedents as per dataset
– Basic Demographics

Antecedents as per dataset
– Basic Demographics



Functional IssuesFunctional Issues
CC– Creating New Variables
• “Transform” -> “Compute”

– Creating New Variables
• “Transform” -> “Compute”

– Selecting Cases (Subsets)
• “Data” -> “Select Cases” 

– Selecting Cases (Subsets)
• “Data” -> “Select Cases” 
• Remember to Unselect them when finished

– Split File
• Remember to Unselect them when finished

– Split FileSplit File
• “Data” -> “Split File”
• Remember to UnSplit file when finished

Split File
• “Data” -> “Split File”
• Remember to UnSplit file when finishedRemember to UnSplit file when finishedRemember to UnSplit file when finished



A l i  d A l i  d Analysis and Analysis and 
InterpretationInterpretationInterpretationInterpretation

Crosstabs, t-tests, ANOVA, EFA
Means byMeans by

Correlation/Regression
Cluster Analysis



General Uses of StatisticsGeneral Uses of Statistics
– Descriptive

Basic look at data
– Descriptive

Basic look at data• Basic look at data
– Data Manipulation

• Basic look at data
– Data Manipulation

• reformat data into alternative useable form
– Basic Examination

• reformat data into alternative useable form
– Basic Examination

• look at differences due to sampling
– Predictive/Causal

• look at differences due to sampling
– Predictive/Causal

• look at effects of one variable on another• look at effects of one variable on another



Comparing Occurrences Comparing Occurrences 
Crosstabs
General Use: Descriptive/Examine
Crosstabs
General Use: Descriptive/ExamineGeneral Use: Descriptive/Examine
Main Use: Tables
Purpose: Tabulate Nominal Data

General Use: Descriptive/Examine
Main Use: Tables
Purpose: Tabulate Nominal Data

Income Total

Low High
Bought Count

13 40 53

Interpretation: if SIG < 0.05 then 
frequencies are not as 
expected

Interpretation: if SIG < 0.05 then 
frequencies are not as 
expected

% of Total
6.9% 21.2% 28.0%

Stole Count
19 117 136p

NOTE: Nominal Data (Frequencies)
p

NOTE: Nominal Data (Frequencies) % of Total
10.1% 61.9% 72.0%

Count
32 157 18932 157 189

% of Total
16.9% 83.1% 100.0%



Central Tendency - MeansCentral Tendency - Meansyy
‘Means by’ and t-test/ANOVA
Gen Use: Descriptive/Examine
‘Means by’ and t-test/ANOVA
Gen Use: Descriptive/Examinep
Main Use:  Describe differences 
Purpose: Test if means are 

l

p
Main Use:  Describe differences 
Purpose: Test if means are 

l

Burn/
Buy

Mean N Std 
Dev

Buy 31.224 49 27.9
equal

Interpretation:  SIG < 0.05 then 
means ARE significantly 

equal
Interpretation:  SIG < 0.05 then 

means ARE significantly 

y
Burn 75.126 119 165.9
Total 62.321 168 147.7g y

different
Remember means are Central 

Tendency they do not

g y
different

Remember means are Central 
Tendency they do not

T-value 2.79 Sig (p) .006

Tendency – they do not 
describe all data  -

Oven and Freezer Problems

Tendency – they do not 
describe all data  -

Oven and Freezer Problems



Data ReductionData Reduction
EFA – Factor Analysis

Gen Use:  Data Manipulation
C C

EFA – Factor Analysis
Gen Use:  Data Manipulation

C C

• Attitudes
– Formative

• Attitudes
– Formative

Main Use:  Create Construct 
Measures

Purpose: Simplify related data

Main Use:  Create Construct 
Measures

Purpose: Simplify related data

Formative
• Summative

– Reflective

Formative
• Summative

– Reflective
Interpretation: look at patterns 

of loadings above 0.50
Usually factor scores are 

Interpretation: look at patterns 
of loadings above 0.50

Usually factor scores are 

• EFA – combine to a 
single score with 
Mean = 0

• EFA – combine to a 
single score with 
Mean = 0y

saved and used for 
further analysis

Not used often in business

y
saved and used for 
further analysis

Not used often in business

Mean = 0, 
• Std Dev = 1

Mean = 0, 
• Std Dev = 1

Not used often in businessNot used often in business



Simple EFASimple EFA
• Analyze ->Data Reduction -> Factor
• Choose Variables
• Analyze ->Data Reduction -> Factor
• Choose VariablesChoose Variables
• “Rotation” – choose “varimax”

Choose Variables
• “Rotation” – choose “varimax”
• “Scores” – Click box to “save as 

variable”
• “Scores” – Click box to “save as 

variable”
• “Options” – Last box

Suppress Absolute Values Put 0 5 in box
• “Options” – Last box

Suppress Absolute Values Put 0 5 in box– Suppress Absolute Values…. Put 0.5 in box– Suppress Absolute Values…. Put 0.5 in box



EFA ExampleEFA Example
Rotated Component Matrix(a)

Componentp
1 2

CopyEth1 .834
CopyEth2 .849
CopyEth3 .882
CopyRisk1 .588
CopyRisk2 .830
CopyRisk3 .723

Extraction Method: Principal Component Analysis. 
R t ti M th d V i ith K i N li tiRotation Method: Varimax with Kaiser Normalization.
a  Rotation converged in 3 iterations.



CorrelationCorrelation
• Gen Use: Descriptive/Examine
• Main Use: Initial Inspection of data
• Gen Use: Descriptive/Examine
• Main Use: Initial Inspection of dataMain Use:  Initial Inspection of data
• Purpose:  Examine bivariate

l ti hi

Main Use:  Initial Inspection of data
• Purpose:  Examine bivariate

l ti hirelationships
• Interpretation: SIG < 0.05 then 

relationships
• Interpretation: SIG < 0.05 then p

variables are related/correlated Exhibit 
13 5 (p 287)

p
variables are related/correlated Exhibit 
13 5 (p 287)13.5 (p.287)

• Exhibits 13.1-13.4 (p. 283-286)
13.5 (p.287)

• Exhibits 13.1-13.4 (p. 283-286)



RegressionRegression
• Main Use: Most used/useful/versatile 

of all analysis techniques
• Main Use: Most used/useful/versatile 

of all analysis techniquesof all analysis techniques
• Purpose: Show relationships/effects

of all analysis techniques
• Purpose: Show relationships/effects

– Draws a line
• Basic Interpretation

– Draws a line
• Basic InterpretationBasic Interpretation

– ANOVA F – if SIG < 0.05 -> Model good
R Squared % of variance explained

Basic Interpretation
– ANOVA F – if SIG < 0.05 -> Model good

R Squared % of variance explained– R-Squared - % of variance explained
– Coef t – if SIG < 0.05 then Coef ≠ 0 (good)
– R-Squared - % of variance explained
– Coef t – if SIG < 0.05 then Coef ≠ 0 (good)



Coefficient InterpretationCoefficient Interpretation
• Y Intercept – basic starting point 

assuming all X variables equal 0
• Y Intercept – basic starting point 

assuming all X variables equal 0assuming all X variables equal 0
• For every unit change in X there is (on 

assuming all X variables equal 0
• For every unit change in X there is (on 

average) a (coef) change in Y  
• Dummy Variables – for a change in X

average) a (coef) change in Y  
• Dummy Variables – for a change in XDummy Variables for a change in X 

from 0 to 1, there is a one time (coef) 
change in Y

Dummy Variables for a change in X 
from 0 to 1, there is a one time (coef) 
change in Ychange in Ychange in Y



e.g., Regression Interpretatione.g., Regression Interpretation
• if F/Anova is significant (sig < 0.05) then continue with 

interpretation 
• if F/Anova is significant (sig < 0.05) then continue with 

interpretation p
• Look at R-Squared 

– Percent of Y explained by X variables

p
• Look at R-Squared 

– Percent of Y explained by X variables

• Individual Coefficients 
– First (B) and last (Sig) number columns

• Individual Coefficients 
– First (B) and last (Sig) number columns
– Look at Sig – if < 0.05 then B is not 0 (ie., variable has an 

effect) 
– Interpret B as degree of change in Dependent(Y) for every

– Look at Sig – if < 0.05 then B is not 0 (ie., variable has an 
effect) 

– Interpret B as degree of change in Dependent(Y) for everyInterpret B as degree of change in Dependent(Y) for every 
unit change in Independent (X)
Interpret B as degree of change in Dependent(Y) for every 
unit change in Independent (X)



Intro to Cluster AnalysisIntro to Cluster Analysisyy
• Main Use:  Segmentation
• Purpose: Form homogenous groups
• Main Use:  Segmentation
• Purpose: Form homogenous groups• Purpose: Form homogenous groups
• Interpretation:  Based on the centers 
• Purpose: Form homogenous groups
• Interpretation:  Based on the centers 

of each group – Normative 
identification
of each group – Normative 
identification

• Usually results are used for further 
analysis ‘save group membership’

• Usually results are used for further 
analysis ‘save group membership’analysis – save group membershipanalysis – save group membership



Two types of ClusterTwo types of Cluster
• Menu – Analyze -> Classify ->
• Two Step Cluster
• Menu – Analyze -> Classify ->
• Two Step Cluster• Two Step Cluster

– Plug and Play
• Two Step Cluster

– Plug and Play
• Put in variables in appropriate spot
• Ratio and Interval in “Continuous” 
• Put in variables in appropriate spot
• Ratio and Interval in “Continuous” 
• “output” – click 

– “create cluster membership variable” box
• “output” – click 

– “create cluster membership variable” box

– Number of clusters determined by data– Number of clusters determined by data



ContinuedContinued
K l tK l t• K – means cluster

– Typically only continuous variables –
• K – means cluster

– Typically only continuous variables –
categorical variables will normally result 
in separate clusters
categorical variables will normally result 
in separate clusters

– User chooses number of clusters
• Either using Logic

– User chooses number of clusters
• Either using Logict e us g og c
• Or more often – trying different solution to see 

what works best

t e us g og c
• Or more often – trying different solution to see 

what works best
– Best – no “small” clusters (few members)
– All clusters are interpretable
– Best – no “small” clusters (few members)
– All clusters are interpretable



Final AssignmentFinal AssignmentFinal AssignmentFinal Assignment

• Write one intelligent sentence 
explaining the results

• Write one intelligent sentence 
explaining the resultse p a g e esu se p a g e esu s



PresentationPresentation

Educational vs Business
KISS PrincipleKISS Principle

Improving Presentations ROT



KISSKISSKISSKISS
• Keep it Simple for the Stupid• Keep it Simple for the Stupid

– Executive Summary
– Graphs/Tables/Exhibits
– Executive Summary
– Graphs/Tables/Exhibits– Graphs/Tables/Exhibits
– No “stat talk”

E ti t h i l di

– Graphs/Tables/Exhibits
– No “stat talk”

E ti t h i l di• Exception – technical audience
– Brief, concise and to the point

• Exception – technical audience
– Brief, concise and to the point



Rules of Thumb for PresentationRules of Thumb for Presentation
f fff ff– Rule of affinity

• Art/graphics/interest – a good visual on every page
– Rule of affinity

• Art/graphics/interest – a good visual on every page
– Know your audience

• Diverse audience is hardest to present to
– Know your audience

• Diverse audience is hardest to present top
• Information at appropriate level
• When in doubt – put it in an appendix

p
• Information at appropriate level
• When in doubt – put it in an appendixp pp

– Backup slides/handouts with more/additional 
information – anticipate questions

p pp
– Backup slides/handouts with more/additional 

information – anticipate questionsinformation anticipate questionsinformation anticipate questions



Written PresentationsWritten Presentations
• Executive Summary

– Summarizes – does not introduce
• Executive Summary

– Summarizes – does not introduce
– ONE page

All important findings contained
– ONE page

All important findings contained– All important findings contained
– Very limited details
– All important findings contained
– Very limited details
– For the executive with limited time
– Ask yourself – “if I had 2 minutes in his 
– For the executive with limited time
– Ask yourself – “if I had 2 minutes in his y

office, what would I tell him about this”
y

office, what would I tell him about this”



Written PresentationsWritten Presentations
• Presentation Style

– Tell a story – relate and transition
• Presentation Style

– Tell a story – relate and transition
– Concise, to the point – the shorter it is, the more 

likely it will be read
– Concise, to the point – the shorter it is, the more 

likely it will be read
– Active Voice 

• No - I will research this issue
– Active Voice 

• No - I will research this issue
• Yes – This issue needs researched

– If research – keep opinions, judgments to the 
conclusion/summary

• Yes – This issue needs researched

– If research – keep opinions, judgments to the 
conclusion/summaryconclusion/summary

– SHOW ME….
conclusion/summary

– SHOW ME….



Oral Presentation/PowerpointOral Presentation/Powerpoint
B k f il t tB k f il t t• Backups – power fails, computers corrupt

• Picture worth 1000 words 
• Backups – power fails, computers corrupt
• Picture worth 1000 words 
• Very limited text, bullets (not like edu)
• Glance test – get the general point
• Very limited text, bullets (not like edu)
• Glance test – get the general point
• Don’t assume – interpret for them
• Details are Oral – graphics are for visuals
• Don’t assume – interpret for them
• Details are Oral – graphics are for visuals
• Any less than 20pt text is unreadable
• Duplicate handouts ensure they won’t pay attn to 

i h d h ld b

• Any less than 20pt text is unreadable
• Duplicate handouts ensure they won’t pay attn to 

i h d h ld byour presentation – handouts should be 
complimentary to the material in the presentation
your presentation – handouts should be 
complimentary to the material in the presentation



Random thoughts in PartingRandom thoughts in PartingRandom thoughts in PartingRandom thoughts in Parting
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